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1.0  FREQUENTLY ASKED QUESTIONS 

a) Who should use this toolkit?

The primary purposes of this toolkit are i) to evaluate the overall source attenuation rate while 
accounting for the effect of random variability in apparent attenuation rates in individual 
monitoring wells and ii) to determine the amount of groundwater monitoring data required to 
characterize the long-term source attenuation rate for sites undergoing long-term monitoring 
(i.e., during an MNA process, either when MNA is a stand-alone remedy or when MNA is applied 
as a polishing step after active remediation).   This tool should be applied at sites where one 
purpose of long-term monitoring is to characterize the rate of contaminant concentration over 
time. 

The toolkit will help the user select an optimal monitoring frequency and evaluate the 
relationship between monitoring frequency and time required to characterize the long-term trend. 

The user can select the optimal monitoring frequency through this process: 

1) Select the primary goal of long-term monitoring:  This optimization method is appropriate
when the long-term monitoring data will be used to either

i) demonstrate that constituent concentrations are decreasing OR
ii) estimate when concentrations will decrease to a clean-up goal

2) Identify the timeframe in which the monitoring goal should be met.  In other words, how
quickly does the demonstration of decreasing concentrations or estimation of time to clean-up
need to be made?

3) Based on the monitoring goal and the decision timeframe, use the Excel spreadsheet toolkit to
determine the appropriate monitoring frequency.

b) What questions are addressed by the toolkit?

Monitoring Variability 

Question 1: When will this site meet the groundwater clean-up goal? 

Question 2: Do any wells appear to be attenuation more slowly than the source as a whole? 

Monitoring Optimization 

Question 1:  How much monitoring data do I need to determine a site’s long-term source 
attenuation rate with a defined level of accuracy or confidence? 

Question 2:  What are the trade-offs between monitoring frequency   and time required for trend 
identification?  

c) What data is required for the implementation of this toolkit?

For a site-specific evaluation of the source attenuation rate and short-term variability, the tool 
requires historical monitoring data for at least four monitoring wells and at least two years’ 
worth of monitoring events (recommended at least five monitoring events) for each well.  Using 
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more historical data will result in more accurate results.  For sites with time dependence in 
short-term variability, monitoring records of six years or longer will yield the most accurate 
results. 

If historical monitoring data is not available, for Monitoring Optimization, the user can enter 
estimated values for short-term variability and long-term attenuation rate (see Section 7.1 of this 
Guide). 

The data evaluation methods used in this tool are based on an assumption of first order source 
attenuation.  The tool should not be applied to monitoring records where first order attenuation 
is clearly not applicable.  For example, the tool should not be applied to monitoring records 
covering an initial period of plume expansion followed by stabilization and decrease.  For sites 
where short-duration active remediation has been applied (e.g., chemical oxidation, thermal 
treatment), the first order source attenuation concept is applicable to the polishing period after 
active remediation is complete.  In other words, the method described in this manual is for long 
periods where the effects of active remediation or natural attenuation processes are relatively 
constant.  Monitoring records before- and after-aggressive remediation should not be combined. 

d) How do I choose between accuracy and confidence?

The user should choose “Confidence” if a primary objective is collecting enough data to 
demonstrate (with a defined level of confidence) that constituent concentrations in the 
monitoring well are actually decreasing over time. 

The user should choose “Accuracy" if a primary objective is collecting enough data to estimate 
the time required to for constituent concentrations in the monitoring well to decline to a 
defined numerical standard based on the observed source attenuation rate 

e) What are the key results?

Monitoring Variability: 

For Question 1: The tool tells you the overall attenuation rate and short-term variability of the 
source area, as well as a range of when you can expect the site to obtain the clean-up goal. 

For Question 2: The tools tells you if the number of wells with observed “slower” attenuation 
rates or with observed “increasing” concentration trends are within the amount expected due to 
short-term variability or if they actually represent slower attenuation or increasing trends.  These 
results allow the user to evaluate whether there are true differences in attenuation rates between 
monitoring wells at a site. 

Monitoring Optimization: 

For Question 1:  The tool tells you your options for sampling in the future to determine the 
source attenuation rate for a defined level of accuracy or confidence.  

For Question 2: The tool tells you the total number of future monitoring events (and estimated 
cost) to characterize the long-term attenuation rate.  Different results are provided for different 
monitoring frequencies (e.g., quarterly, semi-annual, annual). 
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2.0  EXECUTIVE SUMMARY 

The Monitoring Optimization and Trend Analysis Toolkit optimizes groundwater monitoring 
frequency for your site based on site-specific values for the long-term source attenuation rate and 
the magnitude of short-term variability.  The Toolkit includes the following: 

Main Menu: 

1) Choose Monitoring Variability Tool if you have historical data for at least four wells and
at least two years’ worth of monitoring events (recommended at least five monitoring 
events). 

2) Choose Monitoring Optimization Tool if you don’t have historical monitoring data from
your site. 

Monitoring Variability Tool: 

1) Enter at least two years’ worth of most recent monitoring results (recommended at least
five monitoring events) for 4 to 20 monitoring wells.  Use of more monitoring results will
increase the accuracy of the results.

2) After entering data, click “Calculate Results” (may take a while) and then “Review
Results”.  The Results page presents a number of pieces of information to answer the
questions for the Monitoring Variability Tool.

a. To answer the first part of Question 1, the page shows the Long-Term
Attenuation Rate and Short-Term Variability for the source area overall.

b. To answer the second part, enter the Representative Source Area Concentration
(default is the maximum Recent Concentration) and Groundwater Clean-Up Goal
you wish to be used to calculate when the goal will be met.  The tool then
calculates the clean-up time using the 25th and 75th percentile attenuation rates
from the wells.

c. To answer Question 2, the page shows two summary tables detailing the Glide
Paths and Concentration Trends at the site.  Review these tables to determine if
the observed “slower” Glide Paths and “increasing” Concentration Trends are
actually indicative of “slow” Glide Paths or “increasing” Trends or not.

d. Next, review the table that presents, for each well, the Recent Concentration
(average of 5 most recent values), the Long-Term Attenuation Rate, and the
Concentration Trend direction.  This will help you decide if the wells with slower
attenuation rates or increasing trends will delay clean-up attainment.

e. After reviewing all of this, choose click “Show Well Trends”.
3) The Well Trends page shows the two summary tables from the Results page, with graphs

below for each well giving a more in depth view of the trends for each well. Review these
tables for more detailed information on the each well’s effect on clean-up attainment.
Then, click on “Go To Optimization”.

Monitoring Optimization Tool: 

1) Use the Short-Term Variability value and Long-Term Attenuation Rate calculated from
your site data or enter typical values (See Section 6).

2) Set the Historical Monitoring Frequency as the most common type of sampling frequency
for the data already collected, and enter the number of Years of Historical Monitoring
Data Collected.
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3.0  BACKGROUND 

The Monitoring Optimization and Trend Analysis Toolkit provides a method to distinguish 
between random variations in attenuation rates and true spatial differences in remedy 
performance  and provides recommendations for optimized groundwater monitoring frequency 
based on a site-specific evaluation of the magnitude of short-term variability and the long-term 
attenuation rate.  The Toolkit uses site-specific data to determine clean-up horizons and possible 
problem wells and simulated monitoring datasets that match the short-term variability and long-
term source attenuation rate characteristics of your site in order to determine the number of 
monitoring events required to characterize the long-term trend with a defined level of accuracy or 
statistical confidence. 

This User’s Guide focuses on the practical aspects of using the Toolkit.  The development of the 
Toolkit is documented in the report “Task 2 Report: Methods for Minimization and Management 
of Variability in Long-Term Groundwater Monitoring Results, ESTCP Project ER-201209” 
(McHugh et al., 2015). 
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4.0  MONITORING OPTIMIZATION AND TREND ANALYSIS 
TOOLKIT: OVERVIEW

4.1  Platform and Architecture 

The toolkit is built on the Microsoft Excel platform with a user-friendly interface. The tool opens 
on the Main Menu page, which contains a flow chart that directs the user to either the Monitoring 
Variability Tool or the Monitoring Optimization Tool.   

The Monitoring Variability Tool uses historical groundwater monitoring data from individual 
wells in order to calculate the site’s overall short-term variability and long-term attenuation rate. 
Subsequently, the user is directed to the Monitoring Optimization Tool. 

The Monitoring Optimization Tool uses the short-term variability and long-term attenuation rate 
to determine options for sampling frequencies needed to capture the true attenuation rates of the 
groundwater constituents at the site. 

4.2 Basic Structure 

The basic structure of the Toolkit is as follows. Each square indicates what the user will find at 
each step, as well as the name of the page it is found on in parenthesis. 

4.3 General Instructions and Navigation 

Each screen has four main components that help in using the tool and navigating between 
screens:  

i) Instructions
ii) Navigation Panel
iii) Cell Legend
iv) Help Buttons

4.3.1 Instructions 

Instruction boxes are located in the top left corner of all screens and contain specific steps or 
instructions the user should follow in order to operate the page effectively. Each section of the 
page also has the particular Instruction number (i.e., 1,2,3,4) next to the section title. 

Main Menu

Monitoring Variability 
Tool

(Results: Short-Term Variability, 
Long-Term Attenuation Rate, 

and Clean-Up Attainment Info.)

Monitoring 
Optimization Tool

(Results: Optimized Sampling 
Frequency)
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 Dates in MM/DD/YYYY format
 Concentrations as numerical values (i.e., no flags)
 Non-detects replaced with the appropriate numerical values
 All concentration data must be in the same units (either mg/L or ug/L)

As seen in the table below, typical historical groundwater monitoring data can be available in 
many formats and styles, and may require “clean-up” before being entered into the toolkit. 
Various scenarios of original data, and the final required format are presented below. 

Table 1: Examples of Clean-Up Scenarios for Historical Monitoring Data 

Scenario 

Original 
Monitoring Data 

“Cleaned-Up” Format 
Required for Tool 

Notes 
Sample 

Date 
TCE 

Conc. 
Sample 

Date 
TCE 

Conc. 

1 
June 10, 

2001 
250 06/10/2001 250 

Dates in MM/DD/YYYY 
format 

2 3/15/1995 ND 3/15/1995 1 
Non-detects replaced with 

numerical values 

3 8/12/2004 <5 8/12/2004 
5      

(or 2.5) 
Non-detects replaced with 

numerical values 

4 14/1/2003 125 1/14/2003 125 
Dates in MM/DD/YYYY 

format 

5 3/14/1989 45 J 3/14/1989 45 
Concentrations as numerical 

values 

If Yes: Go to a Data Management Tool to clean-up your data (e.g., MAROS).  

A tool such as MAROS can help the user manage data and meet the requirements listed 
above. After completion of this step, navigate back to the Monitoring Variability Tool.  

If No: Go to Monitoring Variability Tool 
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6.0   MONITORING VARIABILITY TOOL 

6.1 Questions 

The Monitoring Variability Tool answers two questions: 

Question 1: When will this site meet the groundwater clean-up goal? 

Question 2: Do any individual wells appear to be attenuating more slowly than the source as a 
whole? 

Going through the Tool will provide the answers to these questions. 

6.2 Input  

6.2.1 Data Entry 

On the Input page the user should enter the following information: 

 Site Info
 Site Name
 Contaminant of Concern
 Concentration Units (Note: This is a dropdown menu of either mg/L or ug/L)

Historical groundwater monitoring data should be entered next as follows:  

 Well Name: This is text (i.e., MW-2)
 Date: Arranged chronologically in MM/DD/YYYY format.
 Concentration: Numerical values (e.g., no text strings) in consistent units (mg/L or µg/L).

The Toolkit allows for the data entry and analysis of between 4 and 20 wells, with data from at 
least two years of sampling events (and a recommended minimum of five events). If more than 25 
sampling events exist at a site, it is recommended to select the 25 most recent sampling events. 

6.2.2 Data Analysis and Results 

No results are displayed on the Input page. 

6.2.3 Navigation 

The navigation options are as follows: 

 Go Back to Main Menu - Takes the user back to the Main Menu page
 Clear Data - Clears all data input thus far
 Calculate Results - Calculates both individual well results and overall (i.e., for the entire

site) results, which can be seen on the Results page.  Results must be re-calculated any
time the data Input page is edited.

 Review Results - Takes the user to the Results page
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6.3 Results 

6.3.1 Data Entry 

 On the Results page, the user should enter the following information: 

 Representative Source Area Concentration: Numerical value that defaults to the
maximum well Recent Concentration

 Groundwater Clean-Up Goal: Numerical value

6.3.2 Data Analysis and Results 

The first data are answers to the first part of Question 1: 

Question 1a: What is the overall attenuation rate for the key contaminant at my site? 

These answers are: 

 Long-Term Attenuation Rate: The overall attenuation rate is the median of the individual
well attenuation rates. A positive value indicates a decreasing concentration trend.

 Short-Term Variability: For the overall dataset, the short-term variability is estimated as
the standard deviation of the natural log of the normalized residual from the attenuation
rate regression analysis.  However, this standard deviation value is optimized to reduce
the influence of outlier values in the dataset.

The Tool then uses the previously entered information to answer the second part of Question 1: 

Question 1b: When will this site meet the groundwater clean-up goal? 

The Tool gives a range of years that the user can expect the groundwater clean-up goal to be 
achieved, based on the 25th and 75th percentile attenuation rates from the wells. 

From here, the Tool shows two summary tables that answer Question 2.  The first – Attenuation 
Rate Summary – shows how many wells can be expected to have Faster, Within Range, or Slower 
Glide Paths (based of Short-Term Variability) and how many wells actually do fall into those 
categories.  The second – Concentration Trend Summary – shows the same information for 
Increasing and Decreasing Concentration Trends.  Based on these results, the Tool provides two 
“Yes” or “No” answers to Question 2. 

Below these tables, data for individual wells is presented, which gives a more detailed look at 
these wells.  The Tool gives the user these instructions: 

What to do next: If the answer to Question 2 is “Yes”, evaluate the individual wells with slower 
attenuation rates or increasing concentrations. Consider whether these wells will delay attainment 
of the overall site clean-up goals. 

In order to do this, the Tool presents these data for each well: 

 Recent Concentration: The average of the most recent five concentration values.
 Long-Term Attenuation Rate
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o Rate: For individual wells, the long-term attenuation rate is estimated using least
squares regression and a first-order (exponential) decay model.  A positive value
indicates a decreasing concentration trend (Newell et al., 2002).

o Glide Path: Identifies whether the attenuation rate glide path for each individual
well is slower or faster than the overall rate for the site.  If the glide path is
“Within Range”, then the difference between the attenuation rate for the well and
the overall attenuation rate for the site is consistent with the effects of short-term
monitoring variability.

o Accuracy: The attenuation rate accuracy is based on the 95% confidence interval
for the attenuation rate as follows.

 High Accuracy: confidence interval <±0.05 or <±25% of
attenuation rate;

 Medium Accuracy: confidence interval <±0.1 or <±50% of
attenuation rate;

 Low Accuracy: confidence interval >0.1 and >50% of
attenuation rate

When the accuracy for a well is “Low”, the user should be cautious in using the 
observed attenuation rate for predicting future contaminant concentrations. 

 Concentration Trend
o Direction: Whether or not the long-term trend shows increasing or decreasing

constituent concentrations
o Confidence: The statistical confidence that the true attenuation rate is not zero.

This is based on the p-value of the attenuation rate at this well.
 High Confidence: p<0.05;
 Medium Confidence: 0.05<p<0.1;
 Low Confidence: p>0.1

6.3.3 Navigation 

The navigation options are as follows: 

 Edit Well Data - Takes the user back to the
Input page

 Show Well Trends - Takes the user to the Well
Trends page

6.4 Well Trends  

6.4.1 Data Entry 

No inputs are entered on the Well Trends page. 

6.4.2 Data Analysis and Results 

On this page, the Tool shows the same two summary tables as on the Results page that answer 
Question 2.  The first – Attenuation Rate Summary – shows how many wells can be expected to 
have Faster, Within Range, or Slower Glide Paths (based of Short-Term Variability) and how 
many wells actually do fall into those categories.  The second – Concentration Trend Summary – 
shows the same information for Increasing and Decreasing Concentration Trends.  Based on these 
results, the Tool provides two “Yes” or “No” answers to Question 2. 

What is p-value? 

The p-value is the probability that 
the apparent pattern in the data 
(e.g., a decreasing concentration 
trend) is due to random chance.  In 
other words, when the p-value is 
less than 0.1, there is a greater than 
90% chance that the observed 
decreasing concentration trend is 
real. 
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Also as in the Results page, below these tables data for individual wells is presented, which gives 
a more detailed look at these wells.  The Tool gives the user these instructions: 

What to do next: If the answer to Question 2 is “Yes”, evaluate the individual wells with slower 
attenuation rates or increasing concentrations. Consider whether these wells will delay attainment 
of the overall site clean-up goals. 

On this page, these data are presented as graphs that show, for each well, the Well Trend in red 
and the Site (Median), Upper 95%, and Lower 95% Trends in black.  This shows the user how the 
individual well related to the rest of the site, to determine if it will delay attainment. 

Below each graph, the Tool shows whether the well has an Increasing or Decreasing Trend and 
whether the Attenuation Rate is Slower, Faster, or Within Range of the Site 95% Confidence 
Trends. 

A key is shown at the top of this page to explain this to the user. 

6.4.3 Navigation 

The navigation options are as follows: 

 View Results - Takes the user back to the Results page
 Go To Optimization - Takes the user to the Optimization page
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7.0  MONITORING OPTIMIZATION TOOL 

7.1 Questions 

The Monitoring Optimization Tool answers two questions: 

Question 1: How much monitoring data do I need to determine a site’s long-term source 
attenuation rate with a defined level of accuracy or confidence? 

Question 2: What are the trade-off between monitoring frequency and time required for trend 
identification? 

Going through the Tool will provide the answers to these questions. 

7.2  Inputs 

The Monitoring Optimization Tool page requires values for:  i) Short-Term Variability and ii) 
Long-Term Attenuation Rate. As such, if the user provided historical monitoring data and ran the 
Monitoring Variability Tool, the two parameters will have been calculated and will appear on this 
page. If no historical monitoring data is available, the user should input typical values for short-
term variability and long-term attenuation rates.  Typical values for these parameters are as 
follows:  

Table 2: Typical Values for Short-Term Variability and Long-Term Attenuation Rate  
Constituent Short-Term Variability Long-Term Attenuation 

Rate 
Petroleum Hydrocarbons 1.0 to 2.0 0.35 yr-1

Chlorinated Solvents 0.5 to 1.0 0.12 yr-1

For characterization of short-term variability and long-term attenuation rates at 20 sites, see Section 4.1 of Task 2 
Report, Methods for Minimization and Management of Variability in Long-Term Groundwater Monitoring Results, 
ESTCP Project ER-201209. 

Information on the historical groundwater monitoring data should be entered next, if applicable:  

 Historical Monitoring Frequency: The sampling frequency for monitoring data already
collected at the site. The user can select from pre-defined options, including: quarterly,
semiannually, etc. If different wells had various monitoring frequencies, please select the
most common type.

 Years of Historical Monitoring Data Collected: The number of years of monitoring data
already collected.  If different wells have been monitoring for different time intervals,
choose a value representative of a typical well.

The user must then calibrate the Tool so the results will be calculated to the desired detail.  As 
such, the user must choose between “Accuracy” and “Confidence”, at a “Medium” or “High” 
level.  

Choose “Confidence” if a primary goal of monitoring is to demonstrate that contaminant 
concentrations are actually decreasing. 

Choose “Accuracy” if a primary goal of monitoring is to estimate the time required for 
contaminant concentrations to decrease to a numerical clean-up goal. 
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These variables are described below. 

7.2.1 Accuracy 

The Optimization Tool will determine how many monitoring events are required to determine the 
long-term attenuation rate with a level of accuracy or a confidence specified by the user.  The 
number of monitoring events is calculated so that 80% of the resulting monitoring records will 
meet the level of accuracy or confidence specified by the user. The accuracy is based on the 95% 
confidence interval for the attenuation rate. 

Two options are available for selection: i) “High” (i.e., the value must be below either 0.05 or 
0.25 times the Long-Term Attenuation Rate, whichever is larger); and ii) “Medium” (i.e., it must 
be below 0.1 or 0.5 times the Long-Term Attenuation Rate, whichever is larger).  Selecting 
“Medium” will result a reasonable minimum amount of monitoring data needed to support 
decision-making.  The user should recognize that, after this minimum is obtained, accuracy will 
continue to increase over time if monitoring is continued. 

7.2.2  Confidence 

The confidence is the statistical confidence that the attenuation rate is not zero, based on the p-
value for the first-order attenuation rate using least square regression. 

Two options are available for selection: i) “High” (i.e., the value must be below 0.05); and ii) 
“Medium” (i.e., value must be below 0.1).  Selecting “Medium” will result a reasonable 
minimum amount of monitoring data needed to support decision-making.  The user should 
recognize that, after this minimum is obtained, confidence will continue to increase over time if 
monitoring is continued. 

7.3  Advanced Controls 

The advanced controls give the user the ability to input a specific value for the level of accuracy 
or level of confidence, rather than “High” or “Medium”.  The user can also specify the percentage 
of monitoring records that will meet the specified level of accuracy or confidence. 

 Accuracy: The confidence interval for the attenuation rate.  If the user enters 0.1, then the
maximum acceptable confidence interval will be ±0.1.  For advanced controls, the user
also specifies the percentage of well monitoring records that must achieve this maximum
confidence interval.

 Confidence: The required maximum p-value for the attenuation rate.  For example, a p-
value of 0.1 corresponds to a 90% confidence that the attenuation rate is not equal to
zero.   For advanced controls, the user also specifies the percentage of well monitoring
records than must achieve this maximum p-value.

 Percent of Wells: The percentage of monitoring well records that will meet requirements
for Accuracy or Confidence.  For regular controls, this value is 80%.  For advanced
controls, the user specifies the value.

7.4  Calculate 
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Once the inputs are set, the user should click the “Calculate and Show Results” button to 
calculate and populate the “Results” table as described in Section 7.4 below. 

7.5  Results 

As previously described, the Tool helps answers two main questions as follows:  

Question 1:  How much monitoring data do I need to determine a site’s long-term source 
attenuation rate with a defined level of accuracy or confidence? 

As the Answer indicates, different sampling options, from weekly to every 5 years, are presented 
in order to understand “how much additional monitoring data you need to accurately characterize 
your long term trend”.  A sample table is shown below. 

Figure 6: Example Sampling Requirements to Characterize the Long-Term Attenuation 
Rate with High Confidence 

This table presents the following values: 

 Sample Frequency - The length of time required to sample at different frequencies, from
weekly (Option 1) to every 5 years (Option 7).

 Total Sampling Events - Number of sampling events that will occur at the specific
sampling frequency for the total time period.

 Cost Per Well - The approximate cost of this sampling program per well, in thousands of
dollars. This value per well is based on a sample cost of $1,500 per event.  This assumed
cost includes labor and materials cost for sample collection, laboratory analysis, data
management, and reporting.

Question 2:  What are the trade-off between monitoring frequency and time required for trend 
identification? 

As the Answer indicates, the table also responds to Question 2, where “[a]ll options presented are 
equivalent”.  These trade-offs are explained below. 

As shown in the “Sample Frequency” column in Figure 6, there are trade-offs between the future 
sampling frequency and the total time of monitoring required. For instance, if the user decides to 
sample once a month, it would take 2.7 years to know a site’s long term source attenuation rate 
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with a defined confidence or accuracy. Comparatively, if the user were to sample once a year, the 
total monitoring time period would be 6.5 years to attain the same information. 

7.6 How Do I Decide between Sampling Options? 

Each of the different sampling options yields a monitoring dataset that can be used to characterize 
the long-term attenuation rate with the same level of confidence and accuracy.  The final choice 
of monitoring frequency should be based on considerations of time and cost, answering the 
question: 

What is the most cost effective monitoring option that will allow me to make decisions within the 
required timeframe? 

Take, for example, a site where MNA has been selected as the remedy with the performance 
requirement that contaminant concentrations are demonstrated to be, in fact, decreasing at the 
time of the first five-year review.  For this site, if the Monitoring Optimization Tool provided the 
monitoring shown in Figure 6, then the user would choose to monitor semi-annually because this 
five years of monitoring at this frequency would serve to document the long-term attenuation rate 
with high confidence.  In contrast, 6.5 years of annual monitoring would be required to determine 
the long-term trend with high confidence, a time period that exceeds the requirement for 
demonstrating decreasing concentrations within five years. 

7.7  Navigation 

The navigation options on this page are as follows: 
 View Well Trends - Takes the user back to the Well Trends page, if the user went through

the Monitoring Variability Tool 
 Calculate and Show Results - Calculates the monitoring frequency results and fills out the

results table 
 Start New Project - Asks the user for confirmation, then clears all current data and brings

the user to the Main Menu page 
 Save & Exit - Allows the user to name and save the file, then exits the Toolkit
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8.0  MISCELLANEOUS  

8.1 Unprotecting Individual Sheets and Viewing Hidden Interface 

Individual spreadsheets and cells within the tool have been protected, except for any input cells. 
In order to generally unprotect the sheet, go to Review on the toolbar, and click Unprotect Sheet. 

In order to view any of the hidden interface, go to File>Options>Advanced or go to View on the 
toolbar and select what you would like to view (eg. sheet tabs, formula bar, or headings).  In order 
to view hidden cells, select cells near the hidden cells and go to Home on the toolbar and click 
Format>Hide & Unhide and select what you would like to unhide. 

8.2 Calculations for Advanced Users   

Several tabs with background calculations have been hidden for simplicity. These can be seen by 
going to Home on the toolbar and clicking Format>Hide & Unhide>Unhide Sheet… and 
selecting which sheet you would like to unhide.. The hidden sheets and a brief description of their 
contents are as follows:  

1. Well Calculations - Calculates the Individual Well Results shown on the Results page.

2. Residuals Calculations - Used to correct the Short-Term Variability to match a log-
normal distribution.

3. Random Data Calculations - Calculates the simulated well data that are checked against
the accuracy or confidence parameters.

4. Trend Calculations – Calculates the trend information for the Well Trends page.

5. Referenced Values - Contains values that are referenced in the Toolkit (e.g. in
dropdowns).
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9.0  LIMITATIONS 

This Excel-based tool has been developed by GSI Environmental under Department of Defense 
contract W912HQ-12-C-0055.  Neither GSI nor any of GSI’s employees, subcontractors, 
consultants, or other assigns make any warranty or representation, either express or implied, with 
respect to the accuracy, completeness, or utility of the information contained herein, or assume 
any liability or responsibility for any use, or the results of such use, of any information or process 
disclosed in this publication, or represent that its use would not infringe upon privately owned 
rights. 

Users of this tool should not rely exclusively on the information contained in this document. 
Sound business, scientific, engineering, and safety judgment should be used in employing the 
information contained herein. 

Where applicable, authorities having jurisdiction should be consulted. 

GSI is not undertaking to meet the duties of employers, manufacturers, or suppliers to warn and 
properly train and equip their employees, and others exposed, concerning health and safety risks 
and precautions, nor undertaking their obligations to comply with authorities having jurisdiction. 
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